Integration Guide
SAP Asset Intelligence Network with SAP Service Cloud and SAP Commerce Cloud
Document Version: 4.0 – 2019-06-30

Integration Guide: SAP Asset Intelligence Network with SAP Service Cloud and SAP Commerce Cloud
June 2019
## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, <code>F2</code> or <code>ENTER</code>.</td>
</tr>
</tbody>
</table>
Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>November 2017</td>
<td>SAP Asset Intelligence Network integration with SAP Cloud for Customer document created</td>
</tr>
<tr>
<td>2.0</td>
<td>February 2018</td>
<td>Document updated for SAP AIN 1802 release</td>
</tr>
<tr>
<td>3.0</td>
<td>July 2018</td>
<td>Document updated for SAP AIN 1805 release</td>
</tr>
<tr>
<td>4.0</td>
<td>November 2018</td>
<td>Document updated for SAP AIN 1808 release</td>
</tr>
<tr>
<td>4.0</td>
<td>February 2019</td>
<td>SAP product name changes</td>
</tr>
<tr>
<td>4.0</td>
<td>June 2019</td>
<td>Document updated for SAP AIN 1906 release</td>
</tr>
</tbody>
</table>
# Contents

1  **Introduction** .......................................................................................................................... 5  
   1.1 About this Document.................................................................................................................. 5  
   1.2 Online Information from SAP ................................................................................................. 6  
   1.3 Naming Conventions ................................................................................................................ 6  

2  **Configuring SAP Cloud Platform Integration System in SAP Asset Intelligence Network** .... 7  

3  **Maintaining User Credentials** ................................................................................................. 8  

4  **SAP Asset Intelligence Network with SAP Service Cloud** ...................................................... 9  
   4.1 Configuring SAP Service Cloud System.................................................................................... 9  
   4.2 Maintaining User Credentials ................................................................................................ 10  
   4.3 Configuring External Systems in SAP Asset Intelligence Network ........................................ 11  
   4.4 Mapping External IDs for Objects with SAP Service Cloud System ....................................... 13  

5  **SAP Asset Intelligence Network with SAP Commerce Cloud** ............................................... 15  
   5.1 Configuring SAP Commerce Cloud as an External System in SAP Asset Intelligence Network ... 15  
   5.2 SAP Hybris Cart via REST API (OCC v2).................................................................................. 17  

6  **Appendix** .................................................................................................................................. 20
1 Introduction

This integration guide primarily discusses the overall technical implementation of SAP Asset Intelligence Network with SAP Service Cloud and SAP Commerce Cloud system. However, additional software dependencies might exist without being mentioned explicitly in this document.

**Note**

The integration information that is presented here serves as an example of how you can use the SAP Asset Intelligence Network application in your company. Ensure that you check your requirements and systems to determine how this can be used productively at your site.

**Recommendation**

We recommend that you test these scenarios thoroughly in your test systems to ensure they are complete and free of errors before going live.

1.1 About this Document

This section describes the concept of how the SAP Asset Intelligence Network (SAP AIN) is integrated with SAP Service Cloud and SAP Commerce Cloud. You can find cross-scenario implementation information as well as scenario-specific information in this guide.

**Note**

The central starting point for the SAP Asset Intelligence Network application is the administration and operations guide, which you can find on the SAP User Assistance Content Platform at https://uacp2.hana.ondemand.com/viewer/p/SAP_ASSET_INTELLIGENCE_NETWORK.

**Purpose**

This section consists of the following main sections:

- Configuring SAP AIN with SAP Service Cloud
- Maintaining User Credentials
- Configuring SAP Commerce Cloud as an External System in SAP AIN
1.2 Online Information from SAP

Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information on documents and guides such as Security, Upgrade or Administrator’s guides relating to SAP AIN</td>
<td><a href="https://help.sap.com/viewer/p/SAP_ASSET_INTELLIGENCE_NETWORK">https://help.sap.com/viewer/p/SAP_ASSET_INTELLIGENCE_NETWORK</a></td>
<td>SAP AIN Help Portal Page</td>
</tr>
</tbody>
</table>

General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td><a href="http://support.sap.com/notes">http://support.sap.com/notes</a></td>
</tr>
<tr>
<td>Released platforms and operating systems</td>
<td><a href="http://support.sap.com/platforms">http://support.sap.com/platforms</a></td>
</tr>
<tr>
<td>System sizing</td>
<td><a href="http://sap.com/sizing">http://sap.com/sizing</a></td>
</tr>
<tr>
<td>Security</td>
<td><a href="http://sap.com/security">http://sap.com/security</a></td>
</tr>
</tbody>
</table>

1.3 Naming Conventions

 Throughout this document the following naming conventions apply.

Terminology

Important terms and terminology that are used in this document.

<table>
<thead>
<tr>
<th>Terminology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP AIN</td>
<td>SAP Asset Intelligence Network</td>
</tr>
</tbody>
</table>
2 Configuring SAP Cloud Platform Integration System in SAP Asset Intelligence Network

Prerequisites

- You have the CONFIGURATION_DELETE or CONFIGURATION_EDIT roles assigned to your user ID.
- You have access to the SAP Cloud Platform Integration account.
- You have the link to access the Integration Flow file.

Procedure

1. Log on to your SAP Cloud Platform Integration Web UI.
2. On the SAP Cloud Platform Integration landing page, click Discover (icon with spectacles).
3. From the SAP Cloud Platform Integration Web UI, choose the SAP Asset Intelligence Network Integration with SAP Service Cloud and SAP Cloud Platform IoT Services package.
4. Choose SAP Cloud Platform Internet of Things Integration for SAP Cloud Platform IoT systems. Choose Tickets Integration or Contracts Integration for SAP Service Cloud integration.
5. Click Copy.
6. From the Cloud Platform Integration landing page, choose the Design tab.
7. From the Integration Flow Package, choose -> the relevant integration artifact -> Actions -> Deploy. The Integration_Flow file is deployed to the SAP Cloud Platform Integration system.
8. To check the deployment status, choose the Monitor tab and verify.
3 Maintaining User Credentials

You perform this procedure to maintain user credentials of an external system in SAP Cloud Platform Integration.

Note
The credentials name is used while creating external system in AIN.

Prerequisites
You have access to a SAP Cloud Platform Integration account.

Procedure

1. Log on to your SAP Cloud Platform Integration account.
4. In the Add User Credentials dialog box, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name denoting the system you are going to configure. For example: HCP IoT</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a meaningful description</td>
</tr>
<tr>
<td>User</td>
<td>Provide the external system ID</td>
</tr>
<tr>
<td>Password</td>
<td>Provide the external system password</td>
</tr>
</tbody>
</table>

Choose Deploy.
4 SAP Asset Intelligence Network with SAP Service Cloud

4.1 Configuring SAP Service Cloud System

You perform this procedure as a prerequisite to configuring external systems such as SAP Service Cloud, with SAP Asset Intelligence Network.

Prerequisites

You have the administrator role configured to your user in the SAP Service Cloud system.

Procedure

Integration settings for Contract Services

- Setting up a new system in SAP Service Cloud
  1. Log on to your SAP Service Cloud account.
  2. On the landing page, go to Administrator section.
  5. In the New Communication System window, enter the following:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>ID</td>
<td>Provide a unique ID</td>
</tr>
<tr>
<td></td>
<td>Host Name</td>
<td>Enter Host name</td>
</tr>
<tr>
<td></td>
<td>System Access Type</td>
<td>Always maintain as “Internet”</td>
</tr>
<tr>
<td></td>
<td>Technical Details</td>
<td>Enter your name, e-mail, phone, and fax</td>
</tr>
<tr>
<td>System Instances</td>
<td>Add new-&gt; System instance ID</td>
<td>Enter a system instance</td>
</tr>
<tr>
<td></td>
<td>Preferred</td>
<td>Web Services</td>
</tr>
<tr>
<td></td>
<td>Application Protocol</td>
<td></td>
</tr>
</tbody>
</table>
6. Choose **Save**.
7. Choose **Set to Active** from the **Actions** section.

- **Setting up a Communication Arrangement**
  1. Log on to your **SAP Service Cloud** account.
  2. On the landing page, go to **Administrator** section.
  3. Under **Integration** section, choose **Communication Arrangements**.
  4. Choose **New**.
  5. In the **New Communication Arrangement** window, select a communication scenario **Query Contracts** from the list in the **Select Scenario**.
  6. In the **Define Business Data** page, select a **System Instance ID**.

  **Note**
  System Instance ID should be the same as that you have created earlier.

  7. In the **Define Technical Data** page, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Method</td>
<td>Select a communication method</td>
</tr>
<tr>
<td>Application Protocol</td>
<td>Always maintain ‘Web Service’</td>
</tr>
<tr>
<td>Authentication Method</td>
<td>User ID and Password</td>
</tr>
<tr>
<td>User ID</td>
<td>You can edit your user credentials</td>
</tr>
</tbody>
</table>

  8. Review and activate the communication arrangement.
  9. You can now view the newly created communication arrangement in the **Communication Arrangement List**.

### 4.2 Maintaining User Credentials

You perform this procedure to maintain user credentials of an external system in SAP Cloud Platform Integration.

**Note**
You have to deploy user credentials twice, one for SAP Service Cloud tickets and the other for contracts.

**Prerequisite**

You have access to the SAP Cloud Platform Integration account.
Procedure

1. Log on to your SAP Cloud Platform Integration account.
2. From the SAP Cloud Platform Integration landing page, choose → Monitor → Manage Security Material
3. Choose → Add → User Credentials
4. In the Add User Credentials dialog box, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><strong>SAP Service Cloud tickets:</strong> Enter any name denoting the system you are going to configure. For example: C4C_USER <strong>Contracts:</strong> C4S_TECHNCAL_USER</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a meaningful description</td>
</tr>
<tr>
<td>User</td>
<td>Provide the external system ID</td>
</tr>
<tr>
<td>Password</td>
<td>Provide the external system password</td>
</tr>
</tbody>
</table>

5. Choose Deploy.

4.3 Configuring External Systems in SAP Asset Intelligence Network

You use this procedure to configure external system in SAP Asset Intelligence Network using Application Settings app.

Context

For simplicity, this procedure explains configuring SAP Service Cloud in SAP Asset Intelligence Network.

Prerequisites

- You have the privileges of an organization administrator, CONFIGURATION_DELETE or CONFIGURATION_EDIT.
- You have already integrated the external system with SAP Asset Intelligence Network. For details, see: Admin Guide at www.help.sap.com/ain.
- Set up external system for SAP Service Cloud
Procedure

Configure SAP Cloud Platform Integration

1. Log on to SAP Asset Intelligence Network.
2. Launch the Application Settings app.
3. Navigate to Systems -> Add -> SAP Cloud Platform Integration

Note

You can configure only one SAP Cloud Platform Integration system in SAP Asset Intelligence Network.

4. In the Add System dialog box, fill in the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Type</td>
<td>SAP Cloud Platform Integration (auto populated)</td>
</tr>
<tr>
<td>System Name</td>
<td>Enter a unique system name</td>
</tr>
<tr>
<td>System Status</td>
<td>Set to Active</td>
</tr>
<tr>
<td>URL Information</td>
<td>Provide the host URL of the SAP Cloud Integration system. For example: <a href="https://cd2ain1-iflmap.hcisb.hana.ondemand.com/">https://cd2ain1-iflmap.hcisb.hana.ondemand.com/</a></td>
</tr>
<tr>
<td>Additional Information</td>
<td>Fill in additional information as necessary</td>
</tr>
<tr>
<td>Is System Primary</td>
<td>Not relevant for this procedure</td>
</tr>
</tbody>
</table>

5. Choose OK.

Configure SAP Service Cloud

1. Log on to SAP Asset Intelligence Network.
2. Launch the Application Settings app.
3. Choose the Systems tab.
4. Choose Add.
5. Choose the external system of type SAP Service Cloud.
6. In the Add System dialog box, provide the details as listed:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Provide a unique system name</td>
</tr>
<tr>
<td>Credential Name</td>
<td>As provided while adding user credentials in your SAP Cloud Platform Integration account.</td>
</tr>
<tr>
<td>System Status</td>
<td>Active or Inactive</td>
</tr>
<tr>
<td>URL Information</td>
<td>URL of the external system.</td>
</tr>
</tbody>
</table>
7. Choose OK.
   The external system with details gets populated in the Systems list in the Application Settings window.

### 4.4 Mapping External IDs for Objects with SAP Service Cloud System

You as an equipment manufacturer are mapping external IDs for an equipment and the corresponding operator with the SAP Service Cloud system. When you have a registered product existing in SAP Service Cloud system, you can:

- Create, edit or view the relevant tickets for the corresponding equipment in AIN.
- View the relevant contracts for the corresponding equipment in AIN.

**Note**
- Registered product in SAP Service Cloud correspond to equipment to AIN. The serial ID of the registered product must be mapped to corresponding AIN equipment as External IDs. The SAP Service Cloud account ID must be mapped in the corresponding AIN company profile as External IDs.
- In case the equipment owner (Source) is different from the equipment manufacturer in AIN, share the equipment with the manufacturer of the equipment with “Write” access. In case you need more information on how to connect with business partners, see Managing your Business Partners. For more information on sharing equipment, see Sharing Business Objects from Object Pages.

### Prerequisites

- The external system in question is already configured with SAP Asset Intelligence Network.
- Your user ID either belongs to the group has the roles EQUIPMENT_DELETE or EQUIPMENT_EDIT or EQUIPMENT_READ assigned.

**Note**
- The mapping is not supported for lean equipment, where there is no model associated to the equipment.

### Procedure

- The manufacturer of the model associated with the equipment maps the External ID on the equipment.
  1. Launch the Equipment application.
  2. Open the item of equipment in question.
  3. Go to External IDs and choose Add.
  4. In the Add External ID window, enter the following:
Field | Description
--- | ---
System Name | Choose the name of the SAP Service Cloud system that you have defined earlier as an external system.
Object Type | ‘Registered Product’
External ID | Enter a registered product’s Serial ID

5. Choose **OK**.
   You see the new External IDs listed on the External IDs page.

- The Manufacturer of the model associated with the equipment maps the External ID for the equipment owner (Source) in the company profile.

6. Launch the **My Company Profile** application.
7. Go to **External IDs**, choose **Add**.
8. In the **Add External ID** window, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Choose the name of the SAP Service Cloud system that you have defined earlier as an external system.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Not required</td>
</tr>
<tr>
<td>External ID</td>
<td>Enter the SAP Service Cloud account ID of the Source of the equipment</td>
</tr>
</tbody>
</table>

9. Choose **OK**.
   You see the new external IDs listed on the **External IDs** page.
5 SAP Asset Intelligence Network with SAP Commerce Cloud

5.1 Configuring SAP Commerce Cloud as an External System in SAP Asset Intelligence Network

You use this procedure to configure external system in SAP Asset Intelligence Network using Application Settings app. For simplicity, this procedure explains configuring SAP Commerce Cloud in SAP Asset Intelligence Network.

Prerequisites

- In SAP Commerce Cloud System
  - You have the administrator role configured to your user in the SAP Commerce Cloud system.
  - Omni Commerce Connect (OCC) v2 must be enabled.
  - Download and unzip the sapjumpinurl addon.
  - Steps to download the addon:
    1. Download
    2. Unzip the sapjumpinurl.zip from the downloaded folder.

  Note
  After downloading the file, you must extract the zip file again. Install the addon on SAP Commerce Cloud system using the following command:

  `ant addoninstall -Daddoninstall procedure: ant addoninstall -Daddonnames="sapjumpinurl" -DaddonStorefront.yacceleratorstorefront=<enter store front name in the hybris system>`

- In SAP AIN system
  - You must have the privileges of an organization administrator, CONFIGURATION_DELETE or CONFIGURATION_EDIT.
  - You have already integrated the external system with SAP Asset Intelligence Network. For details, see: Admin Guide at www.help.sap.com/ain.

Procedure

1. Log on to SAP Asset Intelligence Network.
2. Launch the Application Settings app.
3. Choose the Systems tab.
4. Choose Add.
5. Choose the external system of type SAP Commerce Cloud.
6. In the Add System dialog box, provide the details as listed:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Provide a unique system name</td>
</tr>
<tr>
<td>Credential Name</td>
<td>As provided while adding user credentials in your SAP Cloud Platform Integration account.</td>
</tr>
<tr>
<td>System Status</td>
<td>Active or Inactive</td>
</tr>
<tr>
<td>URL Information</td>
<td>URL of the external system.</td>
</tr>
<tr>
<td>Base Site ID</td>
<td>Base site ID maintained in the SAP Commerce Cloud system</td>
</tr>
<tr>
<td>Webroot</td>
<td>Webroot of the store front name in the SAP Commerce Cloud system</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>If you have maintained a webroot in your SAP Commerce Cloud system, then it is mandatory to maintain the same in AIN system as well.</td>
</tr>
<tr>
<td>Additional Information</td>
<td>If required.</td>
</tr>
</tbody>
</table>

7. Choose **OK**.
   The external system with details gets populated in the **Systems** list in the **Application Settings** window.

   **Note**
   After the configuration is in place, you can view the "Add to Cart" icon for the relevant spare parts in the **Equipment** and **Models** app.

8. Make sure that the **Manufacturer Part Number** in the AIN system is the same as the **Product ID** in the Hybris Commerce system.
Note
After the configuration is in place, you can view the "Add to Cart" icon for the relevant spare parts in the Spare Part app together with Equipment and Models app.

5.2 SAP Hybris Cart via REST API (OCC v2)

This integration works for Hybris B2C solutions, as well as for Hybris B2B solutions. The only impediment could be "secureportaladdon" extension of Hybris, which requires user to authenticate before any Hybris page could be rendered in the browser.
Prerequisites

SAP Hybris with OCC v2 enabled

sapjumpinurl addon installed. standard addon installation procedure: ant addoninstall -
Daddonnames="sapjumpinurl" -DAddOnStorefront.yacceleratorstorefront="yourstorefront" or
define a controller/web method like following (extends
de.hybris.platform.addonsupport.controllers.AbstractAddOnController or
de.hybris.platform.acceleratorstorefrontcommons.controllers.pages.AbstractPageController if used without
addons): @Controller @RequestMapping(value = "/jump-in") public class JumpinUrlController extends
AbstractAddOnController { private static final String CART_GUID_PATH_VARIABLE_PATTERN = "/ {cartGuid: *}");
@Resource private CartFacade cartFacade;
@RequestMapping(value = "/cart/" + CART_GUID_PATH_VARIABLE_PATTERN, method = RequestMethod
.GET) public String prepareCart(@PathVariable("cartGuid") final String cartGuid) throws
CommerceCartRestorationException { cartFacade.restoreSavedCart(cartGuid); return REDIRECT_PREFIX +
"/cart"); }

Use Case

1. Create a new shopping cart via Hybris REST API for anonymous user (no authentication is required)
Request: POST https://{host}:{port}/rest/v2/{baseSite}/users/anonymous/carts
Response example: { "type": "cartWsDTO", "code": "00003000", "guid": "d1d5cd58-26c9-4a5e-9925-81ff56ef11aa", "totalItems": 0, "totalPrice": { "currencyIso": "USD", "value": 0 }, "totalPriceWithTax": { "currencyIso": "USD", "value": 0 }
}
Description: This call creates a new empty shopping cart on Hybris side for the user “anonymous” (as specified in URL). The guid attribute in response identifies the shopping cart, this attribute is to be used in further API calls related to this cart. BaseSite identifies the site from Hybris e-commerce (one Hybris instance might serve multiple sites).

2. Add product to the cart by Hybris product code
Request: POST https://{host}:{port}/rest/v2/{baseSite}/users/anonymous/carts/{cartGuid}/entries
Parameters: • qty – quantity of the product to be added, for example 1 • code – product code as defined in Hybris, for example 816780
Response example: { "entry": { "entryNumber": 0, "product": { "availableForPickup": true, "code": "816780", "name": "DSLR-A100H", "purchasable": true, "stock": { "stockLevel": 2 }, "url": "/Open-Catalogue/Cameras/Digital-Cameras/Digital-SLR/DSLR-A100H/p/816780" }, "quantity": 1, "totalPrice": { "currencyIso": "USD", "value": 1086 }, "quantityAdded": 1, "statusCode": "success" }
Description: This request adds specified quantity (qty) of the product (code) to the cart, identified by guid (obtained in step 1). The unit of measure is specified in request, as in Hybris every product has unit of measure, which will be used automatically, as configured in Hybris. The response contains following important information: • statusCode – “success” if the product was added to the cart successfully; • entryNumber – number of the shopping cart entry that was created during this API call. Should be used in update quantity/delete cart entry requests.

3. Redirect to the Hybris shopping cart page
Request (end-customer should be redirected to the following URL): Redirect to
https://{host}:{port}/{webContext}/jump-in/cart/{cartGuid}

No parameters are passed with this request to the Hybris. When browser is redirected to the following URL, the
new anonymous session is created on Hybris side and shopping cart identified by {cartGuid} is restored. After
this, user will be redirected to the Hybris cart page.

{webContext} should be explicitly provided by the Hybris team/customer, since this depends on the Hybris
configuration (in some configurations the webContext is empty, therefore is not required; in some other cases the
webContext differs from the hybris baseSite).
6 Appendix

Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings (“Code”) included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer ).